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For any administrative assistance please emall
group.admin.stubbins@tnt.com
For any technical advice please contact 01827 711 611
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welcome

to e-administration with TNT

\_

Administration can be a time-consuming process.

When you've got a hundred and one things to do, the last thing
you need is a pile of paperwork to record and file.

Speed and simplicity is what you need.

So to make life easy, we've developed an e-administration system
that enables you to administrate all your accounts — invoices, credits
and statements — in just a few clicks.

It's smart, it's fast and green too. Nothing could be simpler.

This guide tells you all you need to know about using TNT's
e-administration system — the more efficient way of managing
your accounts.
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SERVICES  SHIPPING TOOLS  SUPPORT  ABOUT US F || search

Home ;/ Shipping Tools / e-invoicing / Registration E-invoicing

QUICKLINKS
E-INVOICING

> Services REGISTRATION F . 1 l=ckingTiaes ’
Callback >
» Shipping Tools afibac
Careers »
> Check Transit Times Depot Locator N
3 Check Price Step 1: User Name| / Step 2: Contact Details /Step 3: Account Details / Step 4: Confirmation Check Price »
> Send Package Please enter the username you wish to use to login into the e-invoicing system. We will check this TNT Re-Delivery b
+ Book Collection name has not already been used by another customer before proceeding to the next step of Special Services Booking ?
registration. This one registration will provide you with a single login and password which you can e-invoicing b
> Track Package then use going forward for our e-invoicing selution.
> e-invoicing . . . . )
If you encounter any problems during the registration process click here to send an email to your
> Registration E-invoicing local billing centre.
> Login
Create e-Invoicing Account

> myTNT A generic email address is required and will be used as your login name.
> TNT Re-Delivery

> Special Services Booking Email Address * jill@sutreyfit.co.uk
> Mobile Services The password must be atleast 6 characters long and contain a combination of alpha and
> Shipping Systems numt.aljic characters and must not match your user name. Please note your password is case
sensitive.
> TNT Stationery and Packaging
> Support Password *
> About Us Confirm Password *
The contact email address will be used by TNT for confirming your registration.
Contact email * lill@sutreyfit.co.uk |
* =required fields
Registering for e-invoicing with TNT I. User name
is quick and easy. These details will be used to create your
login user ID including your user name
Go to www.tnt.co.uk and select (preferably your email address) password
e-invoicing from the Shipping Tools and email address.
dropdown menu. This will take you to
the e-invoicing landing page. Now just Once you have completed all the
click the option to register and follow mandatory fields marked with a red asterix,

four simple steps. click next.
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Home / Shipping Tools / e-invoicing / Registration E-invoicing

> Send Package
> Book Collection
> Track Package
> e-invoicing
» Registration E-invoicing
» Login
> myTNT
> TNT Re-Delivery
> Special Services Booking
> Mobile Services
> Shipping Systems
> TNT Stationery and Packaging
> Support
> AboutUs

E-INVOICING

Enter your contact and company details below

If you encounter any problems during the registration process click here to send an email to your
local billing centre.

ICapture Registration Details

Contact Information

FirstName * Jill
Edmans
0123 456 789

Last Name *

Contact Number *

Mobile Number 0345 678912

Company Information

SRFLe |

[_United Kingdom )

Company Name *

Country *

Language *
Notification email Address

Please enter an email address that will receive notification of invoi
to your e-invoicing account.

/credits being p d

Notification email address *  Jill@sutreyfit.co.uk

Additional Notification email Addresses

Please enter the email addresses of any additional people, up to a maximum of 18, to be notified
when invoices/credits are posted to your e-invoicing account

Additional Notification Email

Add Notification Email

QUICKLINKS

Track 'n* Trace

TNT Re-Delivery
Special Services Booking
e-invoicing

i E i United Kingdom [change] larger text print page other sites sitemap Apple Customers contactus 0800 100 600
SERVICES SHIPPING TOOLS SUPPORT ABOUT US [P || search

» Services REGISTRATION ’
Callback »
> Shipping Tools alibact
Careers ¥
> Check Transit Times Depot B N
> Check Price Step 1: User Name |/ Step 2: Contact Details |/ Step 3: Account Details /Step 4: Confirmation Check Price »
>
b
>

2. Contact details
Fill in all your required contact details

including the email addresses of up to
I8 people you wish us to contact when
a new invoice has been posted to your
account. Then click next.
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i ; i United Kingdom [change] larger text print page  other sites sitemap  Apple Customers  gontactus 0800 100 600

sure we aaw SERVICES ~ SHIPPING TOOLS ~ SUPPORT ~ ABOUT US F_————
T

Home / Shipping Tools / e-invoicing / Registration E-invoicing

E-INVOICING
> Services REGISTRATION

> Shipping Tools

> Check Transit Times
Depot Locator

Check Price
TNT Re-Delivery

> Check Price

Step 1: Usarname [ Stap 2: Contact Details |/ Step 3: Account Details |/ Step 4: Confirmation

> Send Package Please enter the details of any TNT account you wish to register. The invoice information given will

vivivvivivivoe

> Book Colection be used to veriy that you are the owner of the accaunt, Press the Submit Account button to verity ‘Spesial Services Booking
 Trock Packago the detais provided. Each account must be added separately and wil appear on the listfo be ewaidng
registered at the foot o the pags, i you have mora than your TNT
> einvoicing Biling Cenire by clicking here.
> Regstration E-invoicing If you encounter any problems during the registration process click here 1o Send an email o your
> Login ocal billng centre.
> myTNT [Account information
> TNT Re-Delivery Account Information

> Special Services Booking

Please enter the full account number including any leading zeros. The invoice
amount is the total invoice amount including VAT. You must enter account

> Shipping Systems details before proceeding to confirmation.

> TNT Stationery and Packaging

> Mobile Services

Account Number * 300508042
> Support

> About Us Invoice Number * 9993

Invoice Ameunt * 9108347.31

How would you fike TNT to invoice you? You can be invoiced electronically via email or by the
traditional paper invoice. Please note traditional paper invoices may be subject 1o a surcharge.

Paper Invoice Required * Yes One ©

If you leave paper invoice required as No, then TNT will email you your invoice. This is TNT's
preferred method as it supports TNT's environmental policy - Planet Me. Please enter the
email address where you wish to receive the electronic invoice,

If you request to receive a paper invoice then you wil be able to downioad an elestranic copy
of your invoice from TNT's e-invoicing application as well as receiving your paper invoice.

‘email Delivery Address * studio@sutreyfit.co.uk.

How would you like TNT to send statements to you? You can be sent statements
electrenically via email or by the traditional paper statement.

Paper Statement Required ©  Yes () No @

If you leave paper statement required as No, then TNT wil email you your statement. This
TNT's preferred method as it supports TNT's policy - Planet Me.
the email address where you wish to receive the electronic statement.

If you request to receive a paper statement then you wil be able to download an electronic
copy of your statement from TNT's e-invoicing application as well as receiving your paper
statement

email Statement Address * studio@sutreyfit.co.uk

List of validated accounts that will be registered

Paper

Account | Email Delivery Address. Invoice?

3. Account

Please ensure you have an invoice that's Confirm whether you'd like to receive send the PDF below and then click
less than 3 months old to hand. Then your invoices electronically and enter the ‘Submit Account’.
complete your account details and verify email address where you'd like us to If you have more than one account,
your customer status by detailing the send the PDF below. Likewise confirm repeat the process and once you have
invoice number and the full amount. whether you'd like to receive your added all your accounts click ‘Proceed
statements electronically and enter the to Confirmation’
email address where you'd like us to
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Home / Shipping Tools | e-invo

> Services
> Shipping Tools
» Check Transit Times
> Check Price
» Send Package
> Book Collection
» Track Package
> e-invoicing
» Registration E-invoicing
> Login
> myTNT
> TNT Re-Delivery
> Special Services Booking
> Mobile Services
» Shipping Systems
> TNT Stationery and Packaging
> Support
> About Us

SERVICES

icin:

United Kingdom [change] larger text print page other sites sitemap Apple Customers contact us 0800 100 600
SHIPPING TOOLS SUPPORT ABOUT US [P || search

! Registration E-invoicing

E-INVOICING
REGISTRATION

Step 1: User Name [ Step 2: Contact Details / Step 3: Account Details |/ Step 4: Confirmation

Please review your details and confirm they are correct. If you need to make changes to your
details use the links above to go back to the appropriate step. Press Register to complete the
process.

If you encounter any problems during the registration process click here to send an email to your
local biling centre.

— ——
(Confirm your details are cormect

Step 1. User Name

User Name Jjili@s utreyfit.co.uk
Step 2. Contact Details

First Name Jill

Last Mame Edmans

Contact Phone 0123 456 789

MNumber

Mobile Phone 0345 678912

MNumber

Contact Email Jjil@sutreyfit.co.uk

Address

Company Details

Company Name SRF Ltd
Country United Kingdom
Language English

Notification Email Addresses

Notification Email
Address

Notification Email Address

Jjili@sutreyfit.co.uk

Step 3. Account Details

P
Account Email Delivery Address ape.r

Invoice?
300508042 | jil@sutreyfit.co.uk No

—— —

| QUICKLINKS

| e-invoicing

Track "n” Trace
Callback
Careers

Depot Locator
Check Price
TNT Re-Delivery

Special Services Booking

| » v v v v v v

4. Confirmation
Now all you need to do is confirm that all
your details are correct and click register.
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elnvoicing@tnt.com

ky.long .CO.
05/08/201011:22 To nicky.long @tnt.co.uk

ot
Subject Welcome to e-invoicing from TNT

Thank you for registering for e-invoicing with TNT.
You can use the system to view new e-invoices, credit notes, statements and search through up to 26 weeks of archived documents accumulated from the date you registered the company.

It's a much more efficient way of working, enabling you to process invoices quickly and accurately in a secure environment. And to make life easy, you can bookmark the page so that you're
automnatically taken to the right page, right away.

As soon as an invoice has been uploaded to your account we will send you an e-mail to alert you that an invoice has been issued. Our e-invoicing user guide and demonstration will tell you all
you need to know about using the system. Simply visit http://www.tnt.co.uk/e-invoicing to find out more.

In the meantime, for any administrative assistance please email group.admin.stubbins @tnt.com or for any technical advice please contact 01827 711611

Thank you for using e-invoicing with TNT - the smarter, greener way of processing invoices.

5. Welcome to e-invoicing

Once you've confirmed your details are correct
we'll send an e-mail to you to let you know that
your registration has been successful.




e-INVoICING

e-statements

\_

TNT's e-invoicing and e-statements system makes the laborious task
of processing invoices and reconciling statements so much easier.

In just a few clicks you can access all your accounts information
without having to waste time searching for invoices in filing cabinets
or filling in data manually.

v

v
v
v

Receive your invoices online
Get email alerts as new invoices arrive

Download invoices/statements as pdfs/excel spreadsheets

Access invoices/statements 24/7/365
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Login
> Login

Registration

» Register for elnvoicing
Help

> Get Adobe Reader

elnvoicing

elnvoicing offers you the ability to see your invoices online.

Login

Language Selection

EnglishGBE &

Login Name

Password

terms of use privacy statement terms & conditions
Intellectual and other property rights to the information contained in this site are held by TNT Holding B.V. with all rights reserved © 2010

There are a number of ways you
can enter the e-invoicing site.

You can log on to www.tnt.co.uk,
select e-invoicing from the Shipping
Tools drop down menu and login to
e-invoicing.

You can go direct to www.express.tnt.
com/e-invoicing/login

Or when we notify you that an invoice
has been posted to your account, you can
click on the www.express.tnt.com/
e-invoicing/login link in the email.

Then simply enter your login name and
password and click the login button.

If you forget your login name or
password simply click on ‘Forgotten

username/password and we'll send it to
your email address (if this is your login
name) and your notification address.

If we don't have your email address we'll
send it to your company'’s registered
user group.
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your new e-invoices and e-statements

dmis tnt.com>

To nicky.long@tnt.co.uk

ce
Subject TNT UK elnvoice

15M2/2010 09:44

Your invoice/credit or statement has now been posted to your secure personal e-invoicing account.

For instant access, simply logen to https://express.tnt.com/elnvoicing and you'll be able to view and download your electronic invoices immediately. You can also access up to 26 weeks of
billing information accumulated from the date you registered, so there's no need to waste any more time searching through files.

Rest assured, our e-invoicing system is legally compliant, giving you a safe environment to access all your billing information in one place.
You'l be pleased to know that your normal payment terms still apply, as detailed on the invoice.
In the meantime, for any administrative assistance please email group.admin.stubbins @tnt.com or for any technical advice please contact 01827 711611

Thank you for using e-invoicing with TNT - the smarter, faster, greener way of processing invoices.

g <group.admin. @tnt.com> To nicky.long@tnt.co.uk
cc
09/10/2010 04:46 Subject Your latest e-invoice / statement from TNT

Please find attached your latest invoice or statement that has been posted to your online account. You'll be pleased to know that your normal payment terms still apply as detailed on your invoice.
Rest assured, we operate a secure system, so we can confirm that the invoice PDF originates from TNT and is authenticated with a digital signature.

Thank you for using e-invoicing with TNT - the smarter, faster, greener way of processing invoices.

000097367 ..DF (28.2 KB)

Notification

You will receive an electronic PDF of
your invoice/statement if you have
requested it, or we will send an email
notifying you that a new invoice/
statement has been posted to your
account and is ready to be accessed.

Simply click on the web-link in the body
of the email and you will be taken
straight to your secure login page.
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elnvoicing

New Documents

Key

/~| PDF Document

| CSVDataFile

A t Numb Invoice Invoice Date Doc Type
> Change Usemname All ] Number | | All [¢
> Email Addresses | |
> Add Account 0 ©B:001115084 00110107 07/01/2011 (Wk1)  Statement

Help 0O cB:001115084 00101210 10/12/2010 (Wk49) Statement
» Customer Portal User Guide O G©B:001115084 03238915 10/1212010 (Wk48) Invoice
> Get Adobe Reader
0O ©B:001115084 03192854 19/11/2010 (Wk46) Invoice
Logout
0O ©B:001115084 00101008 08/10/2010 (Wk40) Statement
> Logout
0O ©B:001115084 03083708 01/10/2010 (Wk39) Invoice
0O ©B:001115084 03054226 17/09/2010 (Wk37)
0O ©B:001115064 03069276 24/08/2010 (Wk;
0O cB:001115084 00100910 Statement
0O cB:001115084 03024850 09/2010 (Wk35) Invoice
@ Remove from New Docum

Amount Due Date

0¥

0.02 GBP 07/01/2011

0.01 GBP 101272010

0.01 GBP

0.01 GBE KE) O O

08/10/2010 8
0.01GBP oaMoizo0 K| O O
o01GBP 240092010 | O O
0.02GBP oiMoi2010 [KE] O O

0.02GBP 10/00/2010 [ (=]
oo1ceP 1omezot0  JoE] O O
Download Selected [}

terms of use privacy statement terms & conditions

Intellectual and other property rights to the information contaj

in this site are held by TNT Holding B.V. with all rights reserved © 2010

Viewing
Once you've logged in, a list of your new
invoices, credit notes and statements will
automatically be displayed. You can view
these as:

e A pdf. This is a soft copy of the actual
invoice that contains exactly the same
information as your paper invoice and
can be printed, emailed or faxed.

* A data file (CSV) This can be
imported directly into your accounting
software.

To view the file in the format you want,
simply click on the corresponding icon
detailed in the key.

If you want to download a number of
different invoices (up to a maximum of
ten), simply select the file formats you
need, click ' Download Selected’ and this
will create a zip file.

Once an invoice has been downloaded or
viewed the file will automatically be moved
to the ‘All Documents’ section of the site.
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Key

Language Selection eInVOiCing . &) PDF Dacument

) osvoai Fie

Documents

> New Documents

New Documents

> All Documents

Preferences
> Change Password A it Numb Invoice Invoice Date Doc Type Amount Due Date View
> Change Username All ¢] Number ‘ | All E
> Email Addresses | | -~
> Add Account 0 ©B:001115084 00110107 07/01/2011 (Wk1) ~ Statement 0.02GBP 07/01/2011 [ =]
Help 0O ©B:001115084 00101210 10/112/2010 (Wk49) Statement 0.01GBP 101272010 [ =]
» Customer Portal User Guide O ©B:001115084 03238915 101212010 (Wk49) Invoice 001GBP 17M22010 i@ O O
? GetAdobe Reader 0O ©B:001115084 03192854 19/11/2010 (Wk46) Invoice 001GBP 26112010 | O O
L:::::ut DO ©B:001115064 00101008 08/10/2010 (Wk40) Statement 0.06 GBP 08/10/2010 i< @]
O ©B:001115064 03083708 01/10/2010 (Wk39) Invoice 0016GBP ogrozotn  JE] O O
O GB:001115064 03054226 17/09/2010 (Wk37) Invoice 001GBP 24092010 [ O O
0 03069276 24/00/2010 (Wk38) Invoice 0.02GBP oiMor2010 K@ O O
0 00100910 10/09/2010 (Wk36) Statement 0.02GBP 10/09/2010 [ =]
0O 03024850 03/09/2010 (Wk35) Invoice 0.01GEBP 10002010 [JUE] O O
(-] Documents Download Selected [E)

& conditions
e information contained |

terms of use privacy statement tel

Intellectual and other property rights site are held by TNT Holding B.V. with all rights reserved © 2010

Removing

To delete items from ‘New Documents’
simply select the one you want to
remove and click the ‘Remove from
New Documents’. This will mark the
invoice as read and transfer it to the ‘All
Documents’ section.
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elnvoi~..g

)-| PDF Do t
Language Selection | cumen

B CSV Data File

» New Documents

» All Documents

Account Number

Invoice Number Invoice Date Doc Type Amount Due Date View
Al I+ 77 \ All +) A &)
GB:001115064 00110107 07/01/2011 (Wk1)  Statement 0.02GBP 07/01/2011 [ 0
> Email Addrasses GB:001115064 00101210 10/12/2010 (Wk49) Statement 0.01GBP 10122010 [ =]
> Add Account
GB:001115064 032368015 10/12/2010 (Wk49) Invoice 0.01 GBP 1711272010 00O
Help

> Customer Portal User Guide 03192854 19/11/2010 (Wk46) Invoice 0.01 GBP 26/11/2010

» Get Adobe Reader

00101008 08/10/2010 (Wk40) 0.06 GBP 08/10/2010

Logout

03083708 01/10/2010 (Wk39) 0.01 GBP 08M10/2010

» Logout

17/09/2010 (Wk37) 0.01 GBP 24/09/2010

(]

000 O0OOD0ODODODO
(]

Invoice 0.02GBP 01/10/2010

GB:001115064 Stalement 0.02GBP 10/09/2010

GB:001115064 03024850 03/09/2010 (Wk36) Invoice 0.01 GBP  10/09/2010 =]

GB:001115064 06113323 13/08/2010 (Wk32) Invoice 0.01 GBP  20/08/2010 =]

GB:001115064 08999104 06/08/2010 (Wk31) Invoice 0.01 GBP 13/08/2010 @]
Download Selected Iy

ivaly statement terms & conditions
er property rights to the information contained in this site are held by TNT Holding B.V. with all rights reserved © 2010

Searching
When you need to search for a
document that you have already viewed,
click on ‘All Documents’ You will be able
to search by:

* Account number
* Invoice number
* Invoice date

* Doc type
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Key

eI"VOlClng J~| PDF Document
Language Selection

CSV Data File

All Documents
> New Documents

T / \

Account Number Invoice Number Invoice Date Doc Type Amount Due Date ew
All [+ V7 | All [+ K=
00110107 07/01/2011 (Wk1)  Statement o201 [ 0
> Email Addreeses GB:001115064 0.01 GBP 10/12/2010 [ 0
7 Add Account GB:001115084 03238915 10/12/2010 (Wk49) Invoice 0.01 GBP 17M12/2010 [ | (S|
H:I:ustomer Portal User Guide GB:001115064 03192854 19/11/2010 (Wk46) Invoice 0.01 GBP 26/11/2010 | 88
> Get Adobe Reader GB:001115064 0B/10/2010 (Wk40) Statement 0.06 GBP 081102010 [ =]
Logout GB:001115064 083708 01/10/2010 (Wk39) Invoice 001GBP oOsoizot0 @] O O
> Logout GB:001115064 03054226 17/09/2010 (Wk37) Invoice 0.01GBP 24002010 | O O
03069276 24/09/2010 (Wk38) Invoice 0.02GBP o1oi010 JNE| O O
00100910 10/09/2010 (Wk36) Statement 0.02GBP 10/00/2010 [ 0
03024850 03/09/2010 (Wk35) Invoice 0.01GBP 10002010 JE| O O
GB:001115064 06113323 13/08/2010 (Wk32) Invoice 0.01 GBP 20/08/2010 - |Eg (=]
GB:001115064 08999104 06/08/2010 (Wk31) Invoice 0.01 GBP 13/08/2010 [~ 00
Download Selected 1)
terms of use pri ment terms & conditions
Intellectual and ot roperty rights to the information contained in this site are held by TNT Holding B.V. with all rights reserved © 2010
Sorting E-archiving
You can organise your invoices by ascending Click the relevant column header once for e-invoicing enables you to store up to 26
or descending order according to: ascending order or twice for descending weeks worth of billing information from
order. the date you registered. After 26 weeks
* Account number the oldest invoice/statement will be
* Invoice number deleted, so remember to download the
* Invoice date files you need to keep on your system.
* Document
* Amount

* Payment due
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Language Selection

Documents

> New Documents hangs Bassword

> All Documents

New Password ﬂ\ ]I

Preferences

Confirm Password
> Change Password

» Change Username

> Email Addresses m
> Add Account

Help

> Customer Portal User Guide

> Get Adobe Reader
Logout

> Logout

terms of use privacy statement terms & conditions
Intellectual and other property rights to the information contained in this site are held by TNT Holding B.V. with all rights reserved © 2010

You can, if you wish, change or
modify your password, login and
user group email settings.

Password Username

To change your password simply click To change your username simply click
‘Change Password' from the Preferences ‘Change Username’ from the

menu, type in your new password, Preferences menu, type in your new
confirm it in the box below and click Username, confirm it in the box below

save. and click save.
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elnvoicing
Language Selection

EnglishCB %

Documents

Email Addresses

> New Documents

> All Documents Notification Email Addresses

Preferences
Email Address
> Change Password
+]

> Change Username

> Email Addresses

3 Add Account Invoice Email Addresses
Help Account Number Email Address
> Customer Portal User Guide & | GB:300508042 jill@sutreyfit.co.uk
> Get Adobe Reader
Logout St Email Add (max 5 per )

> Logout =
Account Number Email Address

@47 | GB:300508042 jil@sutreyfit.co.uk

(5] GB:300508042 +

Please note: Entering an Invoice or a Statement email address will replace your existing paper
document. TNT will email you your invoice and/or statement. This is TNT's preferred method as it

pp TNT's i mental policy - Planet Me.
E-mail addresses
You can add and edit the email addresses lﬁ Enables you to delete email addresses
of your invoice and statement recipients from your natification and
and also add, delete and modify the email statement groups.

addresses of your notification group.
f Enables you to edit existing email

@ Up to 20 email addresses to your addresses in all groups
notification group i
5 email addresses per account in This saves your changes
your statement group
| email address in your invoice group x This cancels any changes that you

have made
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elnvoicing
Language Selection

Documents

o

Add Account
> New Documents

> All Documents Please enter the details of any TNT account you wish to register. The inveice information given will be

Prefarences used to verify that you are the owner of the account. Press the Add button to verify the details provided.

> Change Password Account Information

> Change Username
Please enter the full account number including any leading zeres. The invoice amount is the total
invoice amount including VAT.

> Email Addresses
> Add Account
Help Account Number
> Customer Portal User Guide
> Get Adobe Reader

Logout

> Logout

Invoice Number
Invoice Amount

How would you like TNT to invoice you? You can be invoiced electronically via email or by the
traditional paper invoice. Please note traditional paper invoices may be subject to a surcharge.

Paper Invoice Reguired O Yes @ No

If you leave paper invoice required as No, then TNT will email you your invoice. This is TNT's preferred
method as it supports TNT's environmental policy - Planet Me. Please enter the email address where
you wish to receive the electronic invoice.,

If you request to receive a paper invoice then you will be able to download an electronic copy of your
invoice from TNT's elnvoicing application as well as receiving your paper invoice.

Email Delivery Address

Paper Statement Required O Yes @ No

If you leave paper statement required as No, then TNT will email you your statement. This is TNT's
preferred method as it supports TNT's environmental policy - Planet Me. Please enter the email
address where you wish to receive the electronic statement.

If you request to receive a paper statement then you will be able to download an electrenic copy of your
from TNT's i as well as receiving your paper statement.

Statement Email Delivery Address

Adding an account

To add an account simply complete your
account details and verify your customer
status by detailing the invoice number
and full amount of an invoice that's less
than 3 months old.

Confirm whether you'd like to receive
your invoices electronically and enter the
email address where you'd like us to
send the PDF below. Likewise confirm
whether you'd like to receive your

statements electronically and enter the
email address where you'd like us to
send the PDF below and then click ‘Add".
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There are a number of requirements you need to operate our e-invoicing system.

Required: Web browsers
Latest versions of Microsoft Internet Explorer 6, 7 and 8 and Firefox 3

To view invoices in PDF format
Adobe Acrobat v9.0 and Adobe Reader v8.0

To enable the download of the invoice data (CSV)
Microsoft Excel 97 and above

Minimum Requirements:
Windows 95, NT4, 98, Me, 2000 or XP Professional
Processor — 500 MHz
RAM — 64 Mbytes
Display 800x600 screen resolution and |6-bit colour




For any administrative assistance please emall
group.admin.stubbins@tnt.com
For any technical advice please contact 01827 711 611

TNT Express
TNT Express House Holly Lane Atherstone
Warwickshire CV9 2RY

Your calls may be recorded for training purposes.
The TNT name and logo are trademarks of TNT Holdings N.V.

Effective February 2011




